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In order to submit an article, you must be a registered PCA member and have an approved account.  If you do not have an account on this site, please register for an account by selecting the Register option of the Member Login window. Once your account has approved then you will be able to submit an article.
All articles will be routed to the webmaster for approval before being posted to the website. In order to maintain a consistent look and feel, all articles must follow the format style format discussed in this Content Submission Guide. If you have any questions email the webmaster at webmaster@pcapotomac.com
Create an Article

1. Log in by selecting the Member Login button, located on the site's top right corner. 
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2. A login screen pop up window will display, type user name and password. 
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3. For users who have never logged on before, will be presented with account detail info page and a User Menu on the left navigation. 
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If you have logged on previously to the site, the User Menu will appear on homepage left navigation area. This menu is only displayed if you are logged in.
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4. Begin by selecting Submit Article from the User Menu.
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5. The Editor will be displayed; this where you write and format your new article text, add images, attachment & links (covered in this article).  Before we begin writing our article, first get acquainted with the Editor.
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6. The Editor's functions are accessed from the toolbar, which contains rows of buttons and lists that execute various commands on article content, like bold and underline text.  Place your mouse over the icon to and a text box display the name of the icon. The functions discussed in this article, are the most commonly used. If you wish to see a complete list, visit the Official Editor site. 
1. Title Textbox – Enter Title in this textbox. This will appear as the title on the web page.
2. Text Editor – Type article in this area, or copy text from another source (e.g. MS Word, Excel).

3. Text Effect Icons: This group of functions apply effect on your text. In order to apply an effect to text, you first must highlight the text, then selected the desired icon. 
a. “B” Bold - Apply or remove a bold effect on selected text.
b. “I” Italic – Apply or remove italic effect on selected text.

c. “U” Underline - Apply or remove underline effect on selected text.

4.  Text Alignment – This of functions align text. The position is explained left to right.
a. Justify - Format selected text to full the width of the container element

b. Center – Center selected text or elements.
c. Left – Align selected text or elements to the left.

d. Right – Align selected text or elements to the right.
5. Format Text - Apply a format to the selected text, eg: Paragraph style format will wrap the selected text in a Paragraph style. The PCA Potomac web site uses the “Paragraph” style format for the body text.  This editor will default to Paragraph. All content submitters will adhere to the web style guide, see Format Text section.

6. Directionality - Set the directionality on your (eg: left-to-right or right-to-left), allows you to see the spaces in your article.  

7. Preview – Preview the current article; this is how it’s going to look on the web site.

8. Link - Insert and edit links to articles, web pages, files or e-mail addresses.

9. Image Manager - Upload, delete, rename and insert images.
10.  Spellchecker – Used to spellcheck your article.

11. Add Attachment – Upload an attachment to be included with your article. 
12. Read More - Insert a Read More link anywhere in your article. This will create a break in the article. This feature is useful if the article is going to be used on the homepage. Article tagged as “feature article” in the PCA Potomac website will be displayed on the homepage. 
13. Undo - It erases the last change done to the document reverting it to an older state.
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7. Now that you are a little acquainted with Editor, start by giving your article a Title, which will appear as the article's title on the web page and will also appear on the search engines (so make it a meaningful title). Then type your article and format your article to, see the Format Style section. You may also copy your article from another source (e.g. word, excel), please see Copying an Article and Remove Format instruction on how to this. 
Format and Style 

In order to keep a consistent look and feel throughout the PCA Potomac site, follow the format style guide in this section. All Headings must contain the bolded “Heading 3” format and body text must have the “Paragraph” Format. The example below is properly formatted article.
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In the next few steps we are going to learn how to properly format an article for the Potomac PCA website.
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1. Formatting Headings. Highlight the text, then select the style format from the Format dropdown list, select “Heading 3” and then bold the text by selecting the Bold “B” icon.  Repeat this process for each heading. 
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2. Formatting Body Text. Highlight the text, then select the style format from the Format dropdown list, select “Paragraph”. 
Apply other text effect to your text by highlighting the text, then select the desired 
      icon. 

a. “B” Bold - Apply or remove a bold effect on selected text.

b. “I” Italic – Apply or remove italic effect on selected text.

c. “U” Underline - Apply or remove underline effect on selected text.

     Align text by highlighting the text, then select the desired 
     alignment. 

a. Justify - Format selected text to full the width of the container element.
b. Center – Center selected text or elements.
c. Left – Align selected text or elements to the left.

d. Right – Align selected text or elements to the right
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Now you have applied “Heading 3” to your heading and your body text the “Paragraph” format style. 

Copying an Article

When copying an article into the Editor from another source (e.g. MS Word, MS Excel), the Editor keeps formatting from the original source.  In order to keep a consistent look and feel throughout the PCA Potomac site, follow the web style format, covered in the Format and Style section.  
The best way to avoid formats from another source when copying an article is to the paste the text into the Editor by using the Paste as Plain Text Feature. 
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Let’s begin by looking at the article as it is written in word, see image above. The heading contains font type “Ballonist SF” and the body text contain the font type “Lucinda Calligraphy”. Two text types not used on this site.
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1. Select the Paste as Plain icon (it looks like a clipboard).
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2. An editing window will appear. In order to paste text into this window, this plain text editor will only accept CTRL-V (paste) command. Begin by copying your text from the other source, then place the cursor in this window and select CTRL-V keys. 
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3. Now the text appears in plain text and the format is gone, to complete the copying step, select the Insert button.
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4. The window disappears and your text appears in the Editor. Now you can format your article, see the Format and Style section.

Remove Format

We explained in the Copying an Article section, that you can eliminate format from another source by copying text into the Paste as Plain Text feature.  Another way to remove format is to use the Remove Formatting feature. This feature is also useful anytime you wish to remove existing format from your article. 
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The example above shows what happens when we copy text into the Editor from another source, in this case an MS Word document. The heading contains “Balloonist SF” font type and the body contains “Lucinda Calligraphy” font type. We already learned that the PCA Potomac website does not use this font type, so we have remove these font types from this article.
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1. Highlight the text, then select the Remove Formatting button, it looks like an eraser.
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2. Now the formatting is removed and all of the text will default the body text, which is the "Paragraph" format style. Check your article again, sometimes the reset process will cause some word to squish next each other. Now you can format your article using the PCA Potomac web style guideline in Format an Article section. 

Add Image 

Now that you have typed or copied your article and you want to jazz your article by adding images. 
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1. Begin by placing the cursor in the location you want your image to appear, then 
select the Image icon. 
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2. The Image Manager window will appear. Select the Image Upload icon.
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3. A second window will appear, the Upload window, select the Browse button.
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4. You will be navigated to your desktop, Select the image from your desktop. 
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5. The image will appear on the Upload window, now select the Upload button.
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6. The image will now appear in the File Browser section of the Image Manager. This means that the image is now saved to the server. In the File Browser section, the image file name appears in the middle window and to the right side, is the Details section. In this section you can see thumbnail of your image, as well as details about your image (e.g. size or dimensions, modified date).
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7. Double click on the image file name, located in the File Browser’s middle window. The image URL will appear in the URL text box, located in the Image Properties tab.
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8. Select the Insert button.  
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9. The image will now appear in the article.

Resize an Image
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Resize image by clicking on the image, then select the Image icon. Resize by selecting any of the corners and dragging until desired size is achieved.

Please Note: It is highly recommended to resize the images in photo editing software (e.g. Adobe Photoshop, GIMP, and MS Paint). Images that are originally in high resolution and resized in an article rather than in a photo editing software, tend to affect the site’s performance, causing images to download and render slowly. You may perform minor resizing in the Editor.  All articles and their images will be inspected for quality control. If the image is resized in too high of a resolution, it will be appropriately resized or removed.
 Resize Image by Defining the Size  
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1. Click on the image
2. Select the Image icon

3. Select image size by selecting Dimensions located in the Properties section in the Image      tab 
4. Select the Update button when done

Align Image and Text
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Want to make your article even more stylish? Add text around the image. In the example above, the text appears to the right of the image.
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1. Click on the Image button. The Image Manager window will appear; this where you configure your image as it will appear on your article.
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2. Aligning an imaging. Begin by selecting the Alignment dropdown, located in the Properties section of the Image tab.  Select the Update button when done.
       a. If you want the text to appear to the right of the image, select Left. 
       b. If you want the text to appear to the Right of the image, select Right. 
       c. Select Bottom for text to appear below the image.
       d. Select Top for text to appear above the image.
       e. When selecting Middle for text to appear to right and middle of the image.     
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3. Add space between text and image by adding margin. By adding space between the image and text, makes the text and image appear more esthetically pleasing and professional.

In the Margin section, located in the Properties section of the Image tab, click on the Equal Value check box, then type the number of pixels you want between the image and text. In the Preview section, you can see how your image and text will be display in the article.  

Please use the following guidelines for adding margins:

a. Top= 0 pixels (if the image is on top of the article)
b. Top= 5 pixels (if image will appear in the middle)

c. Right= 10 pixels 
d. Bottom= 5 pixels
e. Right= 10 pixels
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4. When finished, click on the Update button. 
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Now your text and image align nicely together.
Attach a Document
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1. Select the Add Attachment button, located at the bottom of editor.
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2. An Upload Attachment window will pop up, select the Browse button.
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3. Select the file from your desktop.
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4. You will be presented with the upload file you selected and now the system is ready to upload you file. The following warning will appear “NOTE: Your attachment will not be published by default. Please contact your system administrator to have your attachment published.” This means that your article as well as all attachment will be approved before publishing. Finally, select the Upload button.
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5. The attachment will appear below the article.

Add a Link
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1. Highlight the text you want to link, then select the Link icon (looks like chain).
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2. Type or copy link in the URL text box.  If it’s an external link, in the Target dropdown, select the “Open in new window” option. When the link is selected, the page will open a new window. When finished, select the Insert button. [image: image47.png]@09 B:usSEEED o vsm v
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 3. The text will now appear as a link. 
Save Article
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1. Once you are finished writing and formatting your article, by selecting the Save button.
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2. Upon saving, you will be presented with a validation message "Message Article successfully submitted".  Select the "X" to remove the message. An email is sent to the webmaster for approval. The webmaster will notify you when your article has been approved.
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